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1. Main Window 

When Justin is starting the Main program window appears. This window contains Main menu, 
Tool and Status bars, a project and map panes as well. 

 
Figure 1: Main Window 

Below are the terms used in this manual: 

• Project – SQLite database. 

• Dataset – Project table that contains data for unique receiver and antenna pair. 

• Recordset – A query from Dataset. 

• Vector – An object corresponds two overlapped in time Recordsets. 

• Solution – A result of Vector post-processing. 

• Edge – A result of a Solution adjustment. 

• Site – An object created by import raw data file according to standalone, DGPS, RTK 
solutions, header of RINEX, tag in RTCM message. 
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1.1. Project 

 
Figure 2: Project Menu 

The Project menu contains the following items: 

• New project creation. 

• Open a project that already exists. 

• Close a project and save it. 

• Settings for opened project. 

• Compact a project to remove empty records from database. 

• Import – Import observations. 

• Import folder – Import all raw data from a folder and subfolders. 

• Export to – Export program layers to most popular GIS Formats (ESRI Shape, MapInfo 
TAB, MIF/MID, DXF, KMZ/KML, PNEZD, TXT). 

• History list of five recently opened projects. 
Note: Some of Project menu items are duplicated in the toolbar. 
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1.2. Map 

 
Figure 3: Map Menu 

The Map menu contains the following items: 

• Zoom – Zoom In/Out to increase/decrease map scale. 

• Select – Select map feature, select map feature by rectangle, unselect map feature. 

• Pan (Alt) – Pan around map. 

• Ruler – A tool for distance and azimuth measurements. 

• View – View Options for map (Back, Forward, Scale, Snap disabled, Show Meridian and 
Parallel, Background Map, Background Satellites and Clear map cache). 

• Legend – Enable/Disable map legend. 

1.3. View 

 
Figure 4: View Menu 

The View menu contains the following items: 

• Solutions – Open Solution table. 

• Kinematic Solutions – Open Kinematic Solutions 

• Vectors – Justin3 does not create vectors between data provided by receivers defined 
as rovers (rover to rover). 

• Edges – Open the resultant table after adjustments. 

• Recordsets – Open Recordsets. 

• Receivers – Information and control.  
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Figure 5: Receivers Table 

Events – Events information table. 

 
Figure 6: Events Table 

Precise Point Positioning – Opens a table of results. 

 
Figure 7: Precise Point Positioning Table 
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1.4. Tools 

 
Figure 8: Tools Menu 

The Tools Menu contains the following items: 

• Coordinate calculator – Select a source and target coordinate system. 

• Time converter – Opens the Time converter window. 

 
Figure 9: Time Converter 

GPS, Global Positioning System time, is the atomic time scale implemented by the atomic 
clocks in the GPS ground control stations and the GPS satellites themselves. GPS time was 
zero at 0h 6-Jan-1980 and since it is not perturbed by leap seconds. GPS is now ahead of UTC 
by 22 seconds.  
 
UTC, Coordinated Universal Time, popularly known as GMT (Greenwich Mean Time), or Zulu 
time. Local time differs from UTC by the number of hours of your time zone.  
 
Modified Julian Date, MJD, is a modification of the Julian Date that is routinely used by 
astronomers, geodesists, scientists, financiers, and even some historians. This dating 
convention, designed to facilitate simplified chronological calculations, numbers all days in 
consecutive fashion, beginning at a date sufficiently far into the past so as precede the historical 
period. Day Number is an integer counter of the days starting at noon on January 1, 4713 B.C., 
which is Julian Day Number 0. 

  



 

Page 9 of 98 

1.5. Program 

 
Figure 10: Program Menu 

The Program Menu contains the following items: 

• Parameters – Contains a list of Program Parameters, further detailed below. 

• Language – Contains a list of available languages. 

• Coordinate systems – Opens the Coordinate Systems Manager. 

• Reference points – Opens the Reference Points Manager. 

• Antennas – Opens the Antenna Window. 

1.5.1. Parameters 

Selecting Program -> Parameters opens the tabular Program Parameters Window.   

1.5.2. Common Tab 

The Common Tab allows for: 

• Open last project – Open last used project. 

• Use epoch in coordinate transformation – Apply time-dependent coordinate 
transformations. 

• Request for downloading if geoid not exists – Asks for confirmation about downloading 
from JAVAD GNSS repository of Geo Data. 

 

 
Figure 11: Program Parameters Window: Common Tab 
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1.5.3. Import Tab 

The Import Tab allows for: 

• Calculate coordinates – This will calculate coordinates for data import files. 

• Don’t import nested data – This will not import any nested data within import files. 

• Don’t load ephemeris from Internet – This will stop automatically loading ephemeris from 
the Internet. 

 

 
Figure 12: Program Parameters: Import Tab 

1.5.4. Format Tab 

The Format Tab allows for program measurement units (time, units and coordinates) to be 
selected. 
 

 
Figure 13: Program Parameters: Format Tab 
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1.5.5. Report Tab 

The Report Tab shows a list of the supported report types. The supported report types are: 

• Designer 

• Render 

• TXT 

• Csv 

• Html 

• Pdf 

• Word 

• Excel 

• OpenDocCalc 

• OpenDoc 

• Image 

 

 
Figure 14: Program Parameters: Report Tab 

1.5.6. Events Tab 

The Events Tab allows for selection of type of epoch coordinates interpolation. 
 

 
Figure 15: Program Parameters: Events Tab 
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1.5.7. Map Tab 

The Map Tab contains the cartographic data source.  Alternative allows Justin 3 to search for 
maps at the most popular Internet map repositories.  Show grid add a grid on the map and 
Show coordinates panel adds coordinates on the map. 
 

 
Figure 16: Program Parameters: Map Tab 

1.5.8. CORS Tab 

The CORS Tab allows for including/excluding the vectors created using CORS data. 
 

 
Figure 17: Program Parameters: CORS Tab 
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1.5.9. User interface Tab 

The User Interface Tab allows for customization of the process tree and checkboxes. 

 
Figure 18: Program Parameters: User Interface Tab 

1.6. Help 

The Help Menu contains the following items: 

• About – Illustrates the Program, Version, Support Email and creation date. 

• User Manual – Loads this user manual from the Javad GNSS Repository. 

 
Figure 19: Help 
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1.7. Tool Bar 

The Tool Bar consists of icons across the top of the Main Window.  Each Icon is further 
described in the table below. 
 

Icon Description 

 Open New Project window 

 Open Predefined File window 

 Open Project Settings window 

 Compact Project Database 

 Import Observations File 

 Export Project Data 

 Open Coordinate Calculator window 

 Open Time Converter window 

 
Open Coordinate Systems Manager 
Window 

 Open Reference Point Manager window 

 Open Antenna Manager window 

 Increase Map Scale 

 Decrease Map Scale 

 Shows all program layers 

 Cursor Select in Point Mode 

 Cursor Select in Rectangle Mode 

 Unselect 

 Pan the Map 

 Distance / Azimuth Measurement 

 Previous Map position and scale 

 
Initial Map position and scale; used after 

 

 Ruler Snapping Mode 

 Show / Hide Grid 

 Show / Hide Raster Map 

 Show / Hide Space Images 

 Show / Hide Legend 
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1.8. Status Bar 

The Status Bar is designed for progress information of a program routine.  For example, it is 
active during a data import routine (shown below). 

 
Figure 20: Active Status Bar (Data Import Routine) 

The Status Bar is also active during data export, post-processing, skyplot, runtime and table 
view chart creation routines. 
Click  to stop the routine in progress. 
Click  to expand the Status Bar, as shown below. 

 
Figure 21: Expanded Status Bar: Progress Tab 

 
Figure 22: Expanded Status Bar: Log Tab 

Click  to minimize the expanded Status Bar. 

Click  to clear the window. 
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1.9. Project Pane 

The Project Pane is designed to provide full access to program routines. There are four 
operational tabs: 

• Source 

• Process 

• Adjustment 

• Map 

 
Figure 23: Project Pane Tabs 

The available Source Tab menu options depend on Project and Sort options. 

 
Figure 24: Project Pane: Source Tab 
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2. Map Tab 

The Map Tab allows for Layers, Contours and CORS elements, each is further described below. 

2.1. Layers 

The Map Tab provides several predefined layers to control the view of principle objects.  Click 
on the Map Tab to access the layer settings (shown below). 

 
Figure 25: Map Tab: Layer Items 
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Below is a list of icons and descriptions shown in this section. 

Icon Description 

 Recordset track – Collection of points 

 Static vector – Grey line 

 
Kinematic vector – Track, collection of 
points 

 Static Solution – Custom colored line 

 
Kinematic solution – track, collection of 
points 

 Precise Point Positioning (PPP) solution 

 Common edge – Blue line 

 Blunder edge – Grey/Brown line 

 Adjusted PPP solution 

 Site on Standalone coordinates 

 Site on Post-Processed coordinates 

 Site on Adjusted coordinates 

 Site snapped to Reference point 

 Site on RTCM base coordinates 

 Event – Oriented blue arrow 

 Reference Point 

 

2.2. Contours 

Contours are displayed as boundary polylines allowing for several selections (shown below). 

 
Figure 26: Map Tab: Contours 

The checkbox next to the items enables / disables the layer.  Some layers have style settings; 
click the right mouse button on the item to show available style settings. 
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2.2.1. Contour Style Options 

 
Figure 27: Contour Style Options 

2.3. CORS 

Continuously Operated Reference Station (CORS) options are shown below. 

 
Figure 28: Map Tab: CORS 

The checkbox next to the items enables / disables the layer.  Some layers have style settings; 
click the right mouse button on the item to show available style settings. 
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2.3.1. CORS Style Options 

 
Figure 29: CORS Style Options? 
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3. Source 

The Source Tab is for data management (Import / Export, View, Modify). 

3.1. Project 

 
Figure 30: Source Tab: Project Menu 

The root item may vary depending on project options.  Clicking on Project allows the user to see 
the main project menu items (File, Receiver, Dataset, Recordset and Site). File shows items 
about imported files. 

3.2. Sort 

 
Figure 31: Source Tab: Sort Menu 

Files sorted by Date contains common time options. 
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Figure 32: Common Time 

The Receiver item shows a list of receivers that provide raw data files. 
Below is an example of sorting the Receiver item. 
A raw data file may contain GNSS data captured from multiple receivers and antennas (rover 
file with wrapped bases RTCM corrections, multi-antenna receiver file).  We introduce a dataset 
that is a corresponding receiver / antenna pair.  The File may be represented in a project by 
multiple datasets. From the database point of view, dataset is a set of consecutive in time 
records in the project database table that contains raw GNSS data. Datasets are created from 
files during import GNSS files according to program settings.  The file bay be represented in the 
project by multiple datasets. 
A Recordset is a query from Dataset.  By default, every Dataset produces at least one 
Recordset linked to the parent object. 
The user may modify Recordsets with no risk of corruption to the original data because of the 
opportunity to recover it at any time from the parent Dataset.  In the meantime, the Dataset 
automatically produces multiple Recordsets in case of Static / Dynamic event markers, epoch 
gaps, record interval changing inside raw data file and so on. 
The Site is an object created by the import routine and being used as a point GIS feature.  
Coordinates of Site are the standalone solution or provided by the receiver.  Justin separates 
Sites using tolerance. 
The mentioned items may be sorted by some parameters depending on the selected item. 
Sorting options also depends on the selected item. 
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3.3. Import 

This option allows for importing different types of GNSS Data. 

 
Figure 33: Import Observation Files 

3.4. Import Folder 

The Import folder option may be used for batch process of import all valid Justin GNSS data. 

3.5. Clear Project 

The Clear project option is used to remove all GNSS data from a project.  A confirmation is 
needed. 

 
Figure 34: Delete Confirmation Screen 

3.6. Delete Recordsets 

The Delete Recordsets option drops all items. 

3.7. Delete Ephemeris 

The Delete Ephemeris option may be use in case of suspicious ephemeris in original raw data 
files.  Just can download ephemeris data from the internet automatically. 
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3.8. Delete Residuals 

The Delete Residuals option frees the project from a significant number of data generated by 
processes with residuals option. 

3.9. Delete Idle 

The Delete Idle option frees the project from GNSS data useless for Vector post-processing.  
This is the data that has no overlapping time. 

3.10. Repair Vectors 

The Repair Vectors option may be helpful in case the program crashes. 

3.11. Files 

The File menu is designed for managing file objects. 

 
Figure 35: File Object Management 

B, J, R letters above the icons indicate file origin (Broadcasted ephemeris, Jps, Rinex). 
The File item contains related Datasets and Recordsets items. 

 
Figure 36: Datasets and Recordsets 

Import external events file Ashtech (.dat), leica (.ev) formats and .csv.  Event tags are File 
properties. 

3.12. Receivers 

If the user switches the project pane to Receiver mode, the upper item contains Datasets and 
Recordsets.  A red exclamation mark indicates there is no antenna type specified. 
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3.13. Datasets 

Select Datasets option to reconfigure project tree for Datasets. A Datasets tree is shown below. 

 
Figure 37: Datasets 

3.13.1. Table View 

The Table View shows raw data in detail. 

 
Figure 38: Table View 

3.13.2. Thinning  

The thinning option customizes data record interval.  It may remove data from the project. 

 
Figure 39: Thinning 
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3.13.3. Restore Recordsets 

The Restore Recordsets option recreates objects by default program settings (e.g., during the 
import routine). Delete Dataset from the project.  The appropriate file will also be deleted if that 
file corresponds only to one Dataset. 
Multiple Datasets selection (Shift, Ctrl) allows to merge Datasets. Typically used to merge 
hourly raw data. 

3.14. Recordsets 

 
Figure 40: Recordsets 
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3.14.1. General Tab 

The General Tab allows for changes to File name, Alias, Site, Comment, Observer, Agency, 
Begin time / date, End time / date, Interval and Epoch. 

 
Figure 41: Properties: General Tab 

3.14.2. Receiver and Antenna Tab 

The Receiver and Antenna Tab allows viewing and editing of antenna parameters.  Click the 
search icon next to Antenna Type for the antenna list. Slant(SHMP), shown next to Type means 
slant height measurement point. 

 
Figure 42: Properties: Receiver and Antenna Tab 
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3.14.3. Satellites Tab 

The Satellites Tab shows GNSS Satellites and Signal information.  Yellow circles mark 

unhealthy satellites whereas green circles mark healthy satellites. The icon  
indicates the ratio of present/absent signals. 

 
Figure 43: Properties: Satellites Tab 

3.14.4. Skyplot Tab 

The Skyplot Tab shows a current skyplot of along a timescale shown on the left. GPS is 
indicated by green, GLONASS is indicated by red, Galileo is indicated by blue, and Beidou is 
indicated by yellow.  Use the timescale slide on the left to scroll between epochs. 

 
Figure 44: Properties: Skyplot Tab 
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3.14.5. Table View 

The Table View shows raw data in detail. 

3.14.6. Epochs 

The Epoch option shows a table as follows: 

 
Figure 45: Epoch Table 

• Solution Type – navigational, float, fixed. 

• Engine – Receiver or Justin calculated coordinates. 

• Status – Depends on receiver or Justin solution. 

3.14.7. Raw Data Chart 

The Raw Data Chart option shows base to rover single differenced GNSS signal values. 
Interferometry shows satellite to satellite single differenced GNSS signal values.  Statistics are 
shown on the status bar. 

 
Figure 46: Raw Data Chart 
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3.14.8. Motion Mode 

Justin automatically detects Recordsets type during import criterion for static in Project 
properties settings and Static / Dynamic tags / events inside the file.  Default criterion equals 5 
meters means that all epoch positions expected withing 3*5 = 15 meters for static.  Here it is 
possible to change Recordsets type. 

3.14.9. Split 

The Split item contains two options: By time or by parts.  The By time option generates new 
Recordsets with a selected fixed time interval. 

 
Figure 47: Split Recordset by Time 

The By parts option generates new Recordset with the same time span. 

 
Figure 48: Split Recordset by Parts 

  



 

Page 31 of 98 

3.14.10. Export 

The export option allows for JPS or RINEX filetypes.  The RINEX version (2.10, 2.11, 3.04) may 
be selected as well. 

 
Figure 49: Export Options 

When exporting RINEX, several settings are available and are shown below. 
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Figure 50: Export RINEX Options 

3.14.11. Report 

The Report option creates a report using a Table View structure. 

3.14.12. Zoom 

The Zoom option focuses on Site associated with Recordset. 

3.14.13. Visible 

The Visible checkbox shows / hides the track of epoch positions on a map. 

 
Figure 51: Visible Checkbox 

3.14.14. Delete 

This option will delete the Recordset.  This will not delete the raw data. 
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3.14.15. PPP 

The PPP option will run a computation of Precise Point Positioning.  It is recommended to use 
daily data using a 30 second interval. 

 
Figure 52: PPP 

3.14.16. Sites 

Sites are created by Justin using the Recordset.  If Recordsets overlap in time, they create a 
vector that can be post-processed. 

 
Figure 53: Sites 

Icon Description 

 Reference Point Site 

 Standalone Site 

 RTCM Base Site 

 Post-Processed Solution Site 
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4. Post Processing 

Post-Processing is a vector option. Recall that Recordsets which have time overlapped GNSS 
observation sessions yield a vector.  A goal of post-processing is a Solution.  Depending on a 
type of rover Recordset, we distinguish static or kinematic modes of post-processing.  Type of 
Recordset is figured out just after importing GNSS data relative to criterion for static in the 
project settings.  Justin offers type editing though Recordset properties dialog. 
Active Process tab in a project pane to get access to post-processing. 
Post-Processing could be run in a batch mode via vectors item in a process tab of project pane. 

 
Otherwise, use Selection by point / rectangle tool in the main toolbar for post-processing 
through the map. 
The post-processing of static data yields the increments of coordinates from base to rover in the 
geocentric coordinate system.  The static solution is shown on the solution layer as a line object.   
 

4.1. Vectors 

The post-processing of kinematic data yields a set of solution vectors so-called fan.  The 
kinematic solution is shown on the map as a collection of point objects.  The point positions are 
the end of the solution vectors.  We use band and rover indications for terminal points of a 
vector. 
The static engine, as well as the kinematic one, use so-called single differences of GNSS Data.  

4.1.1. Vector Node Options 

Vector options include: 

• Sort… - Initially vector’s tree is structured by date of the start of timespan.  Click Base or 
Solutions number option to look how they are working. 

• Process – Run post-processing on all unprocessed Vectors. 

• Settings – Open process settings window described below. 

• Unhide – Shows all hidden Vectors. 

• Delete Solutions – Delete all Solutions from a project. 

• Delete Residuals – Delete all solution residuals. Be aware that residuals take more room 
in a project than a solution does. 

 
Figure 54: Vectors Node Options 
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4.1.2. Settings 

 
Figure 55: Vectors – Settings 

4.1.2.1.1. Static Tab 

Using the Static option, the default item is Engine. Regular Justin software is delivered with one 
default engine.  By request, additional engines may be activated. 
 
Engine mode options include: 

• Auto – Auto detect best combination of base and rover overlapped data. 

• L1 only – Process L1 data only. 

• L2 only – Process L2 data only. 

• L5 only – Process L5 data only. 

• L1 & L2 & L5 – Process L1, L2, and L5 data together. 

• Wide lane – Process L1 and L2 data in wide lane combination. 

• Float – Not integer processing in Auto mode. 

• Code – Code processing. 
 
Troposphere options include: 

• Model – A list of popular Troposphere models. 

• Pressure, Humidity, Temperature – Input of parameters; humidity value affects altitude. 
 
General options include: 

• Cut off angle – Rejection of satellite data under entered value. 

• Max distance – Maximum baseline length (in km). This value is a focus during batch 
processing, some vectors may be skipped. 

• Use precise ephemeris – Process vectors using precise ephemeris if those are available 
on the date of processing. Just can automatically download ephemeris from the Internet. 
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• Save residuals – store residuals in a project database. Residual is result of subtraction 
measured code or carrier phases values (depending on processing mode) and a 
distance between final receiver position and satellite. Storage of residuals make post-
processing slower. The residuals chart is a main tool to control post-processing results 
for data captured in a bad environment. 

• Interpolate base -Interpolate base GNSS data if rover data sampling is different. 

• Lift and Tilt – Forces processing of the Rotation Matrix (RM) message data. 
 

Click on  to access the line style to be shown on map. 

 
Figure 56: Line Style Options 

The next option in the Static Window is Satellites.  This option allows for the user to enable / 
disable satellites. 
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Figure 57: Satellites Options 

4.1.2.1.1. Kinematic Tab 

 
Figure 58: Process Settings - Kinematic Tab 
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The Kinematic tab allows the user to augment the Engine mode, data, RMS values, 
constellations and several general options. 
 
Engine mode options include: 

• Code Diff – Process code only data. 

• Code Diff Smoothed – Process code data smoothed by phase. 

• Code Carrier Float – Float processing. 

• Carrier Fixed – a priori root mean square error of code measurements. 
 
RMS Options are important for weighting of code and phase data for outlier rejection.  The RMS 
Code and Carrier phase can be augmented to improve fixing in a difficult environment. RMS 
options include both Code (in meters) and Carrier phase. 
 
Data options include: 

• L1 – Process L1 data only. 

• L2/L2 – Process L1 and L2 data. 
 
General options include: 

• Elevation mask – Rejection of satellite data under entered value. 

• Memory factor – weight for passing epochs. It affects how fast engine forget old data. It 
is very import for high dynamic applications. 

• SNR threshold – Cut off data by Signal to Noise Ratio (SNR). 

• Iono factor – Combined factor of data random noise error. 

• Fix level – Setup Contrast ration of integer procedure. 

• GPS, GLONASS – Enable / Disable GPS and/or GLONASS data. 
 

4.1.3. Data Item 

The Data item options include: 

• Process – run post-processing for all associated vectors. 

• Hide – Make vectors invisible. 

• UnHide – Make vectors visible. 

• Delete Solutions – Delete all solutions. 

 
Figure 59: Vector Data Options 
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4.1.4. Base 

The next level of the Vectors tree corresponds to the base object, shown below as base site 4 

and is denote by , the static Recordset Icon. 

 
Figure 60: Vectors Tree 

4.1.4.1. Base Node Options 

Base node options include: 

• Process – Run post-processing for all unprocessed vectors. 

• Delete Solutions – Delete all solutions related to the base node. 
 

 
Figure 61: Base Node Options 

4.1.5. Rover 

The next level of the Vectors tree corresponds to the rover object, shown above as rover site 

254 and is denoted by , the static Recordset Icon. 

4.1.5.1. Rover Node Options 

Rover node options include: 

• Process – Run post-processing if no solution exists. 

• Runtime – Used to get more than one solution. 

• Delete Solutions – Delete all Solutions. 

• Properties – Opens a vector properties window.  View base and View rover opens 
relative Recordset properties windows. 
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Figure 62: Rover Node – Properties 

• Differences – Chart of GNSS signal differences. 

 
Figure 63: Rover Node – Signal Differences 

• Common Satellites – Opens a chart. 
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Figure 64: Rover Node - Common Satellites Chart 

• Inverse – Redirect vector. 

• Zoom – Focus on vector (on map). 

• Visible – hide / unhide vector on map. 
 

4.1.6. Solutions 

The last level of the Vectors tree is for solutions.  These appear under the rover node after post-
processing.  Initially, the rover node is empty.  Processing adds a solution to an item. 

4.2. Batch Processing 

Multiple vectors can be post-processed by using the vectors tree item or by selectin them from 
the map using the  or  tools. 

 
Figure 65: Multiple Vectors (Batch) Processing 

The processing progress is shown on the bottom status bar (shown below). 
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Figure 66: Batch Processing Status Bar 

 
Figure 67: Batch Processing - Expanded Status Bar - Log Tab 

4.3. Single Vector Processing 

Single vector processing can be used to further refine solutions yielded from batch processing. 
Click the Vector item on the Vector tree or select from the map. 

 
Figure 68: Vectors Selected - Runtime Option 

Once the Runtime option is selected, the bottom pane appears (shown below). 
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Figure 69: Runtime Option Selected - Bottom Pane 

 - Run post-processing 
 - Run post-processing by parts.  Click on it to produce multiple solutions. 

 

 
Figure 70: Process by Parts 

 - Multiple or single satellite strips selection mode. 
 - Erase all Selections. 
 - Erase red strip. 
 - Print a chart. 
 - Save chart as a raster file. 
 - Show entire timeline (after zooming). 

 
The left pane is intended for enabling / disabling satellites and the start / end times may be 
edited.  The settings button opens the settings tab of properties which is further described 
below.  The Common sats and SkyPlot were previously described. 
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4.4. Solution 

The solution is accessible through the map and from the project pane. 

 
Figure 71: Solution Menu Options 

4.4.1. Properties 

Selection of Properties option opens the Solution Properties window.  The first tab shown is the 
coordinates tab (shown below). 
 
The coordinates tab shows: 

• Base and Rover coordinates on epoch date of the project. 

• Solution components in XYZ. 

• Sigma’s are diagonal elements of correlation matrix. Only coordinate systems declared 
within the project are available. 
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Figure 72: Solution Properties - Coordinates Tab 

The Statistics tab shows: 

• Total and left code and phase data in the solution. 

• Number of total and left phase ambiguities. 

• Time span equals epoch number multiplied by record interval.  

• RMS residuals = sqrt(sum(sqr(v)) / n), v – residual, n – epoch number. • Fix ratio – 
Fisher statistics. 

• Left Satellites used. 

• Min/km = Time span divided by length. 

• Begin, End time shows time tag of observation session. 

• Process time is post-processing time and date. 
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Figure 73: Solution Properties - Statistics Tab 

The Antenna tab shows: 

• Type – antenna model (NGS US convention) 

• Height Type – antenna measurement point. 

• Height Value – direct distance between measurement point and ground point. 

• Offsets – distances between ground point and point of interest. 

• Serial – antenna serial number. 
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Figure 74: Solution Properties - Antenna Tab 

The Satellites Tab shows a snapshot of the Timeline plot. 

 
Figure 75: Solution Properties - Satellites Tab 
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The Settings Tab shows a snapshot of the post-processing settings window. 

 
Figure 76: Solution Properties - Settings Window 

4.4.2. Residuals 

This option opens a plot displaying residual values contained in the recordset.  Residual 
statistics are shown in the status bar on the bottom. 

 
Figure 77: Residuals Plot 

Statistics for a single satellite can be displayed or exported by right-clicking on the preferred 
satellite in the right pane.  Select ‘View’ for a plot or ‘CSV’ to export (shown below). 
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Figure 78: Display / Export Single Satellite Residual Data 

4.4.3. Report 

This option will open a solution report. Report options (time, time format, coordinate system, unit 
type, angle type, angle and length rounding) are available (shown below). 

 
Figure 79: Report 
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5. Adjustments 

Geodetic network adjustment uses a Weighted Least Squares method for solving over 
determined linear systems (𝐴𝑋 = 𝐿).  Depending on the dimensions (2D / 3D) of the adjustment, 
the design matrix 𝐴 has 3𝑛 or 2𝑛 rows (where 𝑛 is the number of solutions) and a structure 

comprising of +1 and −1. 𝑋 is a matrix of unknown node coordinates.  The number of 
unknowns 𝑚 equals the number of network nodes multiplied by 3 or 2.  𝐿 is an array of solution 

components 𝑑𝑋, 𝑑𝑌, 𝑑𝑍.  In the case of adjustment in geocentric linear equations, the equation 
system is: 

𝑋𝑀 − 𝑋𝑁 = 𝑑𝑋, 

𝑌𝑀 − 𝑌𝑁 = 𝑑𝑌, 
𝑍𝑀 − 𝑍𝑁 = 𝑑𝑍, where 𝑋, 𝑌, 𝑍 are unknown coordinates of 𝑀 and 𝑁 network points. 
 

The redundancy of the network adjustment is the number of rows minus the number of columns.  

This is subject to a weight matrix 𝑊.  The solution of 𝐴𝑋 = 𝐿 is then 𝐴𝑇𝑊𝐴𝑋 =  𝐴𝑇𝑊𝐿, where 𝑊 
is a block diagonal matrix formed using solution covariance matrices. 
 
The network adjustment solves two main problems: 

1.) Post-processing solution accuracy estimation and outlier / blunder detection. 
2.) Calculation of final ground point coordinates tied to reference points and statistics. 

 
Solution accuracy (1.) runs in inner-constrained mode.  To overcome the singularity of the 

normal matrix 𝐴𝑇𝑊𝐴, we use a singular value decomposition (SVD) method.  The research of 
networks adjusted in inner-constrained mode detects the impact of outliers / blunders in the 
post-processing solution accuracy estimation. 
 
The detection of outliers / blunders is treated using Pope’s 𝜏 − 𝑡𝑒𝑠𝑡.  This method computes 

standardized residuals 𝑢𝑖 =
𝑣𝑖

√𝑞𝑖𝑖
 to detect outliers / blunders in iterations and remove suspicious 

data from the design matrix.  Iterations continue until outliers / blunders have been minimized 

and the 𝑋2 − 𝑡𝑒𝑠𝑡 is passed depending on the significance level (68%, 95%, 98%) and the 
degrees of freedom. 𝑞𝑖𝑖 are diagonal elements of the cofactor matrix: 

𝑄𝑣𝑣 = 𝑄𝑙𝑙 − 𝐴𝑄𝑥𝑥𝐴𝑇, where 𝑄𝑙𝑙 is a block diagonal matrix of 3x3 dimension solution and 𝑄𝑥𝑥 is 

the invers of the 𝐴𝑇𝑊𝐴 matrix.  The 𝜏 − 𝑡𝑒𝑠𝑡 treats the solution as an outlier / blunder if a 

residual exceeds the 𝜏 − 𝑣𝑎𝑙𝑢𝑒. 
𝜏𝛼0

2
, 𝑛 − 𝑚 is determined in 𝜏 − 𝑑𝑖𝑠𝑡𝑟𝑖𝑏𝑢𝑡𝑖𝑜𝑛, ∝0= 1 − (1−∝)

1

𝑛, 

where ∝ is a user-defined significance level.  Level 99% corresponds to minimum restrictions 

whereas level 68% corresponds to maximum restrictions.  Note that the 𝜏 − 𝑡𝑒𝑠𝑡 uses 
standardized residuals for outlier / blunder detection instead of absolute values, so small 
residuals can be treated as outliers / blunders as well. 
 
The Least Squares method deals optimal results in geodetic adjustments if GNSS data post-

processing solution errors are normally distributed. The 𝑋2 − 𝑡𝑒𝑠𝑡 checks if the solution errors 

are normally distributed by comparing unit weight error 𝜇 and 𝑋2 statistics. 

𝑋2
1−∝

1
2

,𝑛−𝑚
<  𝜇2 =  

1

𝑛 − 𝑘
(𝑉𝑇𝑊𝑉) <  𝑋2

∝
1
2

,𝑛−𝑚
 

The 𝑋2 − 𝑡𝑒𝑠𝑡 estimates the consistency of the solution covariance matrix, 𝑄𝑙𝑙, relative to a 

posteriori statistic.  A failed 𝑋2 − 𝑡𝑒𝑠𝑡 indicates the GNSS data logging sessions were too short 
and loop closures are often big with 𝜇 out of limits. 
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The inner-constraints adjustment runs in relative coordinate systems. To show inner adjustment 
results in a cartographic window, we snap relative coordinated networks (Net) to the first listed 
reference point (if it exists) or to the first listed site. 
 
For the calculation of final ground point coordinates (2.), the network (Net) must be snapped to 
the ground reference points and the final adjustment should be run under external constraints.  

5.1. Net  

To start the adjustment, switch to the adjustment tab in the project pane.  Solutions that 
complete the process procedure are subject to adjustment.  The first step of the adjustment 
procedure, using inner constraints (detailed above), is to evaluate loop closures.  Justin 
software uses the edge category to show loops.  The edge category will appear as a result of 
the solution adjustment.  The solution is a result of vector post-processing and a special layer, 
edges, represented in the map pane. 
Loop closures represent additional estimates of post-processing data accuracy.  Loop closures 
are the sum of solution components.  Loop detection is running during the network adjustment 
procedure. 

 
Figure 80: Adjustments - Net Tree 

Upper items in the Adjustment tab are: 

• Net – Main adjustment item. 

• Sites – list of adjustment objects. 

• Reference Points – List of control ground points with postulated coordinates using 
external-constraints. 

• Solutions – Subjects of adjustments 
o Blunders – not passing the 𝜏 − 𝑡𝑒𝑠𝑡. 
o Disabled – Solutions excluded in interactive mode. 
o Common – Solutions passed all tests and included in the final results. 

• Kinematic – Kinematic solutions (detailed below “Adjustment of Kinematic Solutions”). 

• Precise Point Positioning – Site precise positions. 
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Figure 81: Adjustment – Network 

Sites are point objects shown on the map with cartographic signs relative to the legend.  Sites 
are generated from standalone raw data Recordsets solutions.  The cartographic sign reflects 
its origin (receiver calculated, standalone, post-processed or adjusted).  The snapped sites are 
green in color. 
Shown above:  

• TXAN is a standalone solution. 

• TXTI is a post-processed solution. 

• TXCU is snapped to a reference point. 
 
Edges are linear objects created by adjustments.  Edges connect to adjusted sites and from a 
network as shown above.  Edges are shown on a special map layer.  An edge table exists in the 
adjustment report to show residuals and relative error.  There are several edge types: 
Single-ended – Share only one site within the network (TXCU → TXHA). 
Bridge – Connects Loops (TXPL → TXKC). 
Blunder – Failed the 𝜏 − 𝑡𝑒𝑠𝑡, colored brown by default (TXPL → TXKC). 
Common – Passed the 𝜏 − 𝑡𝑒𝑠𝑡, colored blue by default (TXKC → TXED). 
Loops – A list of independent loops generated under the restriction of minimum edges quantity 
in a loop.  Loop closure residuals are indicated depending on adjustment mode (XYZ / NEU).  
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5.1.1. Net Menu 

Right-click on ‘Net’ to show Net menu items. 

 
Figure 82: Adjustments - Net Menu 

• Adjust – Run a network adjustment.  The last adjustment will be dropped. 

• Settings – Opens the adjustment settings window (detailed below). 

• Clear – Drops the last adjustment. 

• Reports – Generates a selectable popular format report. 

• Exports – Exports files in selectable popular formats. 
 
Adjustment settings allow for selections of blunder rejection, constraints, loops, blunder 
detection and confidence level. 

 
Figure 83: Adjustments - Network - Adjustment Settings 

• Blunder Rejection – This is how blunders are processed. 
o Automatic Rejection – Runs adjustments in iterations where blunders are 

detected and excluded step-by-step until they are minimized (batch blunder 
processing). 

o Interactive Rejection – Runs adjustments in an interactive dialog window (shown 
below) step-by-step allowing the user to cancel a solution at each iteration (step-
by-step blunder processing). 

• Blunder Detection – Blunder qualification in inner-constraints adjustment. 
o XYZ – Residuals are calculated in a geocentric coordinate system. 
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o NEU - Residuals are calculated in the topocentric coordinate system.  There is 
additional specifications of 2D / 3D to separate horizontal and vertical sources of 
error.  If an edge is marked as a blunder in NEU 3D mode, it follows to readjust 
the network as 2D to excluded vertical error components due to data input error 
(e.g. antenna height). 

• Confidence Level – Post-processed solutions based on GNSS data obtained in short 
sessions of observation may have low absolute accuracy and small standard deviation 
errors overvaluing its impact in the adjustment due to large values within the weight 
matrices.  Edge residuals must not exceed sigma more than 2-5 times in the case of 
normal distribution or errors.  Otherwise, the solution should be detected as a blunder.  
Confidence level settings allow for control of the blunder detection procedure.  Unit 
weight error must correspond to solution accuracies.  Regular 𝜇 − 𝑣𝑎𝑙𝑢𝑒 varies from 0.4 

to 1.6. 𝑋2
1−∝

1

2
,𝑛−𝑚

<  𝜇2 =  
1

𝑛−𝑘
(𝑉𝑇𝑊𝑉) <  𝑋2

∝
1

2
,𝑛−𝑚

 computes more accurate limits using 

the degree of freedom and confidence interval values.  99% is the weakest limit.  The 

blunder detection procedure will affect the 𝑋2 − 𝑡𝑒𝑠𝑡.  Control of confidence levels for 

both tests allow the 𝑋2 − 𝑡𝑒𝑠𝑡 to pass well. 

• Constraints 
o Inner – Adjustment of a free network with no constraints.  Residuals depend on 

network geometry and solution quality.  It is a significant preliminary network 
adjustment which run automatically within a constrained network.  It is 
recommended to run it in advance separately to minimize blunders / outliers. 
Inner-constraints adjustment computes site positions in a relative coordinate 
system.  The results may be similar to a fixed constraints adjustment with one 
reference point. 

o Fixed – Adjustment which can be completed if network sites were snapped to at 
least one reference point. If not snapped to at least one reference point, Justin 
will provide a warning to the user. The statistic of the accuracy of reference 
points does not affect the residuals or computation but can be used for accuracy 
estimation. 

• Loops – Constant 𝐸 (in meters) and linear parameter 𝐴 (in ppm) define an acceptable 

limit for loop closure.  An equation is ∆𝐿 = 𝐸(√𝑁) + 𝐴𝐿; where 𝑁 are the number of 

edges in a loop, 𝐿 is the length of a loop. Loops with overpassed closure are colored red 
in the left project pane. 

 
Shown below is the interactive dialog window which appears if blunder rejection is set to 
interactive. 
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Figure 84: Adjustments - Network - Network Settings - Interactive Blunder Detection Dialog Window 

The interactive dialog window shows a list of network edges and the X, Y, and Z components of 
edge residuals along with tau statistics in a table format.  The tau column shows the maximum 
components of standardized residuals along the X,Y,Z / N,E,U axes.  To the right of the table 
shows common network statistics: 

• Common tau-value. 

• Unit weight error (UWE). 

• Low and High limits of the 𝑋2 − 𝑡𝑒𝑠𝑡 for UWE. 
 
To exclude an edge from the adjustment, select a row in the table and click ‘Reject’.  Press and 
hold the Ctrl or Shift button to exclude more edges at once.  By clicking ‘Reject’, the ‘Restore’ 
button re-runs the adjustment.  The dialog window will re-generate to continue.  The ‘Complete’ 
button allows the user to end the iterative process. 

The goal of interactive mode is to pass the 𝑋2 − 𝑡𝑒𝑠𝑡. It is recommended to exclude edges with 
the highest values in the tau column.  It is not possible to reject a bridge edge as it will split the 
network into two sub-networks.  If attempted, Justin software will warn the user of this 
impossibility.  In the case were a network needs to be divided into 2 or more sub-networks, the 
user should disable the edge solution prior to the adjustment process.  A rejected edge is kept 
in the table, but the values are excluded from the adjustment and are shown in gray. A rejected 
edge may be restored by selecting it and clicking ‘Restore’. 

5.1.2. Kinematic Solutions 

Processing data from multiple kinematic bases generates new trajectory objects in the 
Kinematic node with options: 

• Adjust – This will run a kinematic solutions adjustment. 

• Properties – This will show the properties of the new trajectory object within the 
Kinematic node. 

• Zoom – This will show the entire trajectory. 

• Delete – This will drop the last adjustment from the project and redraw the map. 

• Report – This will generate a standard report. 
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Figure 85: Adjustments - Network - Kinematic Solution - Trajectory Object Menu 

 
Figure 86: Adjustments - Network - Kinematic Solution - The Kinematic Adjustment 
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Figure 87: Adjustment - Network - Kinematic Solution – Trajectory 

Selecting a row in the table pane generates the orange portion on the graph (shown above). 
 
The kinematic adjustment could be running if multiple base solutions exist.  In this case, only the 
Kinematic node is populated.  A new trajectory object is intended to control the adjustment 
workflow. 
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5.1.2.1. Kinematic Settings 

Kinematic settings are accessed by clicking on the kinematic item and selecting settings, this 
will open the Adjustment settings window (shown below). 

 
Figure 88: Adjustments - Network - Kinematic Solution - Kinematic Settings Window 

Options in the Adjustment settings window include: 

• Use Fixed Solution – Only fixed solutions are used in the adjustment. 

• Fixed Priority – Ignore other solutions weaker than a fixed solution (float, ect.) if a fixed 
solution exists. 

• Use Float Solution – Both float and fixed solutions will be used in the adjustment within 
the solution covariance matrices. 

• Maximum Length of Base Line – Sets a maximum range parameter acceptable in the 
adjustment.  This is the distance between the base and rover epoch positions. 

 

5.1.2.1. Kinematic Report 

This option will generate a standard report with kinematic settings used. 

 
Figure 89: Adjustments - Network - Kinematic Solution - Kinematic Report? No New Image 
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6. Project Settings 

The Project Settings are located within the main program window. Click on Project – Settings to 
gain access to this option. 

 
Figure 90: Project Settings - Project – Settings 

The left side of the Project Settings window contains: 

• Filename – Name of the current project file. 

• Created – Date and Time of project file creation. 

• Creator – Optional information of project file creator. 

• Agency – Optional information of project file agency. 

• Comment – Optional comment information. 
 
The right side of the Project Setting window contains: 

• Max epoch gap – The maximum number of skipped epochs between any two adjacent 
epochs within data. 

• Min sample size – The minimum number of epochs to process the data. 

• Criterion for static – The coefficient multiplied by the standard error of the epoch for the 
data.  If the coordinates calculated for all epochs are inside a circle with a radius equal to 
the criterion, the data is determined by Justin as static.  Otherwise, the sample is defined 
as kinematic. 

• Tolerance for static – The maximum distance at which the recordsets refer to the same 
point. 

• Max vector length – The maximum length of processed vectors. 

• Epoch – The date of the project 
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7. Coordinate Systems Manager 

The Coordinate Systems Manager is accessed using the main menu program item or by clicking 

the coordinate systems manager icon . 

 
Figure 91: Coordinate Systems Manager 

The default coordinate systems are WGS84, WGS84 (ECEF), and World Mercator. 

 
Figure 92: Default Coordinate Systems 

Click the add subfolder  to add a subfolder to the Favorites root item subfolder’s name. 

 
Figure 93: Subfolder Addition 

Click on the customize the list of preferrable coordinate systems  if needed. 

 
Figure 94: Customize Coordinate System List 

  



 

Page 61 of 98 

7.1. GeoData Database 

To search in the Javad geodata database, select the preferred geodata subset. 

 
Figure 95: Geodata 

Click on the subset to expand the item and continue to the desired folder: 

 
Figure 96: Item Expansion 
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Opening the desired folder brings up the specific list of preloaded coordinate system: 

 
Figure 97: Selection of Coordinate System 

If “Custom transformation” is checked, an additional window with a list of valid transformations 
appears after clicking “Next”. 

 
Figure 98: Custom Transformation 

Click on the search button  to search, then to input stored in file transformation, then “Add” or 
“Back” to return. 
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7.2. Create a New Coordinate System 

To create a new coordinate system, either click on the  button or right-click on the Favorites 
item, then select “New”: 

 
Figure 99: New Coordinate System 

A new window with options of coordinate system types will appear: 

 
Figure 100: Coordinate System Type Selection 

Select the Projection (Grid) option to specify the datum.  It is possible to select on of the existing 
datums or create a new one.  Datum parameters correspond to the transformation from 
ITRF2008(WGS84), which is the main system in Justin. 

7.2.1. Specify a new Datum 

Specify the ellipsoid from the drop-down menu or input new parameters: 

 
Figure 101: New Datum Specification 

Clicking “Next” allows for input of the 7 parameters of the Helmert transformation: 
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Figure 102: 7 Parameter Input 

Clicking “Next” allows for projection selection: 

 
Figure 103: Geoid Selection 

 
Figure 104: Projection Selection 
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Next, specify geoid or click “Skip”. Then select ellipsoid: 

 
Figure 105: Select Geoid or enter own Geoid 

 
Figure 106: Projection Details 

Clicking “Next” allows for entering the new coordinate system name: 

 
Figure 107: Coordinate System Name 

Clicking “Add” finishes creating a new coordinate system. 
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7.3. Coordinate System Options 

Selecting a coordinate system from the Favorites menu allows for coordinate system options. 

7.3.1. Properties 

Selecting Properties opens the selected coordinate system properties window, shown below. 

 
Figure 108: Coordinate System Properties 

7.3.2. Edit 

Click this option to edit the selected coordinate system.  Every complete coordinate 
transformation from WGS84(ITRF2008) to a target coordinate system is a chain of consecutive 
transformation.   
Icons on the top bar of the Edit window contain: 

•  - Save Transformation. 

•  - Save Transformation with new name. 

•  - Add Transformation. 

•  - Insert Transformation. 

•  - Delete Transformation. 
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Figure 109: Coordinate System Edit Window 

The far-left panel is designed for input / output coordinates in WGS84(ITRS2008).  The far-right 
panel is designed for input / output coordinates in target coordinate system.  Each panel in the 
middle represents consecutive transformations.  These middle panels are highlighted by green / 
red to indicate correct / incorrect links between output data from the previous transformation and 
input data on the current transformation. 

 
Figure 110: Coordinate System Edit Window 

Validation between transformations is detected by coincidence type of input / output data.  The 
type of transformation is shown on the bottom: 

•  - ECEF. 

•  - Geodetic. 
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•  - Grid. 

•  - Combined (variant types of coordinates). 
Transformations can be forward and backward, indicated by colored arrows: 

•  - Forward. 

•  - Backward. 

Transformations can be added using the  icon, inserted using the  icon or removed using 

the  icon. 
The selected transformation is highlighted by the blue frame. 

 
Figure 111: Edit Window - Selected Transformation 

Transformation parameters can be added or inserted: 

 
Figure 112: Add / Insert Parameters 

Geoids can be added: 

 
Figure 113: Geoid Options 

A localization can be added: 

 
Figure 114: Localization Options 

After selection options bases on the selected system, the user will need to select the panel 

where the data will be sued to determine the geoid height.  Click  for information about the 

reference system.  To change geoid files, click the  icon.  New geoid files will be copied to 
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Justin’s program geoids folder. Valid transformations have all panels colored in green, only valid 

transformations may be saved; either by the save  icon or by the save as  icon. The name 
and type should be unique.  To rewrite an existing coordinate system, select it in the window 
below. 

7.3.3. Backup / Exchange 

Creation of a backup file for the Favorites item is recommended as it assists in the case of new 
Justin version installation or running several instances of Justin on multiple PC’s.  Click on the 

create backup file  icon with naming conventions: 
Parameter_Year-Month-DayTHours-Minutes-Seconds.jcs, where file is saved in 
C:\Users\Username\Documents\Justin\CoordinateSystems folder. 
 
To restore a Favorites list from a list of backup files from the 
C:\Users\Username\Documents\Justin\CoordinateSystems folder. Click on the restore Favorites 

 icon.  A list of restore points will show in a window: 

 
Figure 115: Restore Points 

Coordinate systems can be exchanged using the right pane of the Coordinate systems manager 
window. Click on the Project tab to activate: 

 
Figure 116: Active Project Tab? No new Image 

Use the left and right buttons shown on the left to copy coordinate systems from the program 
database to a project.  The Import tab allows the user to click on a selected coordinate system 
and click open.  A copy can be made from the Import tab by selecting a coordinate system and 
clicking on the left button to copy that coordinate system to the program database. 
The export tab allows for exporting a coordinate system by selecting the clicking on the right 
button.  Coordinate systems can be saved by selecting that option from the drop-down menu. 
The Reference points tab allows for the user to copy coordinate systems to the Favorites 
program database using the left button. 
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Figure 117: Coordinate System Manager Window 

7.3.4. Other Options 

• Rename – Click on the selected object to rename and edit the name. 

• Cut – Use an option for cut and paste. 

• Copy – Use an option for copy and paste. 

• Paste – Use an option for pasting from buffer. 

• Clone – Create an instant copy; will have suffix of ‘_Clone’. 

• Delete – Deletes the item after confirmation. 
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8. Reference Points 

Justin software treats reference points as points within a catalog of postulated coordinates.  
Raw data post-processing results in vector components in XYZ / NEU.  Justin needs at least 
one reference point in the preferred coordinate system for post-processing components to be in 
this same preferred coordinate system.  In practice, the user will collect data in the field over the 
preferred reference point and collect data in the field over the preferred rover point.  Getting raw 
data from both locations, snap the beginning of processed vector to reference point and adjust. 

8.1. Reference Point Manager 

Click on the reference point manager  icon, located in the toolbar, to open the Reference 
point manager window. 

 
Figure 118: Reference Points - Reference Point Manager Window 

The Reference point manager window toolbar contains: 

•  - Creates a new folder. 

•  - Creates a new reference point in a selected folder and enable the right panel for 
editing and saving. 

•  - Import exchange files (.jst). 

•  - Export reference points (.jst or .txt). 

•  - Creates a backup file. 

•  - Opens backup files. 
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The Reference point manager window’s left panel has Reference points as the root item.  It may 
contain some subfolders.  Clicking on folder items invokes the menu, shown below. 

 
Figure 119: Reference Point Manager - Left Panel - Folder Menu 

Items in the left panel folder menu contain: 

• New folder – Creates a new subfolder. 

• New reference point – Creates a new reference point in a folder. 

• Copy – Copies item to buffer. 

• Paste – Pastes from buffer into the selected folder. 

• Clone – Clones a folder. 

• Delete – Deletes a folder. 

• Import – Opens dialog window to import file points (.jst) into the folder. 

• Export – Exports a folder in selected file format (.jst or .txt). 
 
The right panel of the reference point manager window offers four tabs (Edit, Project, Import and 
Export).  
The Edit tab allows for editing of reference point properties, shown below. 

 
Figure 120: Reference Point Manager - Right Panel - Edit Tab 
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Depending on the item in focus, the right panel may be empty (  folder selected) or contain 

reference point information (  reference point selected).  Click  to start with a new point: 

 
Figure 121: Select New Point 

 Click  to open a list of accessible coordinate systems.   

 
Figure 122: Select Coordinates 

Select preferred coordinate system, then type coordinates, and click save to add a new point to 
the list in the left panel’s selected folder. 

 
Figure 123: New Point Added to Left Panel’s Selected Folder 

Click on the Speeds/Epoch tab to view or type speeds if required.  Time-dependent coordinate 
systems use predefined velocities (e.g., HTDP transformations), user-defined speeds have 
priority. 
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Figure 124: Speeds/Epoch Tab 

 
The Project tab opens the project repository and reference points exchange.  Use the left and 
right buttons to copy folders and reference point items. 
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9. Localization 

To convert the coordinates obtained by GNSS data processing from WGS84 to a local 
coordinate system, it is required to: 

1.) Have reference coordinates in the local coordinate system. 
2.) Have coordinate transformations which connect the local coordinate system to WGS84.   

 
The order in which coordinates are calculated is shown below: 

 
Figure 125: Coordinate Transformation Order 

Transformation of geocentric coordinate systems is performed by the formula of 7 parametric 
Helmert transformations (Amendment 2 of RTCM Standard 10403.1): 
 
𝑋𝑇

𝑌𝑇

𝑍𝑇

=
𝑑𝑋
𝑑𝑌
𝑑𝑍

+ 𝑀 ∗ 𝑅 ∗

𝑋𝑆

𝑌𝑆

𝑍𝑆

 (9.1), where 𝑋𝑆 , 𝑌𝑆, 𝑍𝑆 and 𝑋𝑇 , 𝑌𝑇 , 𝑍𝑇 are WGS84 geocentric coordinates 

and reference coordinate system accordingly (S=Source, T=Target); (𝑑𝑋, 𝑑𝑌, 𝑑𝑍) are 

translations along the axes (X, Y, Z); 𝑀 is the scale factor. 
 
𝑀 = (1 + 𝑑𝑆 ∗ 10 − 6). The size of 𝑑𝑆 is indicated in the list of datum Justin parameters in ppm. 
 
The rotation matrix 𝑅 = 𝑅𝑋 ∗ 𝑅𝑌 ∗ 𝑅𝑍𝑅𝑋 ∗ 𝑅𝑌 ∗ 𝑅𝑍, where: 

𝑅𝑋 =
cos 𝑅1 sin 𝑅1 0

−sin 𝑅1 cos 𝑅1 0
0 0 1

, 𝑅𝑌 =
cos 𝑅2 0 − sin 𝑅2

0 1 0
sin 𝑅2 0 cos 𝑅2

, 𝑅𝑍 =
1 0 0
0 cos 𝑅3 sin 𝑅3

0 − sin 𝑅3 cos 𝑅3

 (9.2) 

 
𝑅1,𝑅2,𝑅3 are angles between axes of source and target coordinate systems. Axes are counted in 

the clockwise direction. 
The formula of inverse transformation: 

𝑋𝑆

𝑌𝑆

𝑍𝑆

=
𝑅−1

𝑀
[[

𝑋𝑇

𝑌𝑇

𝑍𝑇

] − [
𝑑𝑋
𝑑𝑌
𝑑𝑍

]] (9.3) 

 
The Helmert transformation is a similarity transform in which the scale factor is the same for 
each coordinate. The combination of the 7 parameters for transformation 
(𝑑𝑋, 𝑑𝑌, 𝑑𝑌, 𝑑𝑆, 𝑅1, 𝑅2, 𝑅3) and the ellipsoid is called the datum.  In the list of Justin datums, the 
signs of the parameters correspond to the transition from WGS84 to the reference system. 
Example: 𝑑𝑋 = +10 𝑚𝑒𝑡𝑒𝑟𝑠. 𝑋𝑅 = 𝑋(𝑊𝐺𝑆84) + 10. 
The calculation of geodetic coordinates with the use of geocentric coordinates (item 2 of the 
transformation scheme) is performed by iterations using the formulas: 

tan 𝐿 =
𝑌

𝑋
,  

tan 𝐵 =
𝑍

√𝑋2+𝑌2
+

𝑒2∗𝑁∗sin 𝐵

√𝑋2+𝑌2
, (9.4) 

𝐻 =
√𝑋2+𝑌2

cos 𝐵
− 𝑁. 
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Where 𝑁 is the radius of curvature of the first vertical, 𝑒2 is the square of the first eccentricity of 
the ellipsoid.  The reverse transition to rectangular coordinates X, Y, Z from geodetic 
coordinates B, L, H is described by the formulas: 
𝑋 = (𝑁 + 𝐻) ∗ cos 𝐵 ∗ cos 𝐿, 

𝑌 = (𝑁 + 𝐻) ∗ cos 𝐵 ∗ cos 𝐿, (9.5) 

𝑍 = (𝑁 + 𝐻 − 𝑒2 ∗ 𝑁) ∗ sin 𝐵. 
Where 𝑒 is eccentricity and 𝑁 is the radius of curvature of the first vertical. 
To calculate geodetic coordinates, there is a need to specify an ellipsoid (semi-major axis and 
eccentricity).  The transformation of geodetic coordinates B, L into rectangular coordinates on a 
plane is performed based on the type and parameters of the map projection.  The transition 
from 𝐻𝑔𝑒𝑜𝑖𝑑 geodetic (ellipsoidal) height, which is measured along the normal to the ellipsoid, to 

𝐻𝑜𝑟𝑡ℎ𝑜 orthometric height is performed by the formula: 

𝐻𝑔𝑒𝑜𝑖𝑑 = 𝐻𝑜𝑟𝑡ℎ𝑜 + 𝜁, (9.6) where 𝜁 is the height of the geoid above the ellipsoid. 

Geoid heights are determined from geodetic coordinates based on a geoid model that is defined 
relative to the same ellipsoid for which the geodetic height is calculated. The transformation 
performed between two rectangular coordinate systems is specified on the plane.  Finding the 
parameters of the transformation is typically called localization or calibration.  Planned 
transformation formulas are: 
𝑁𝑇

𝐸𝑇
=

𝑑𝑁
𝑑𝐸

+ 𝑀 ∗ 𝑅 ∗
𝑁𝑆

𝐸𝑆
, (9.7). Where 𝑅 = [

cos 𝛼 − sin 𝛼
sin 𝛼 cos 𝛼

]. 

𝑁𝑇 = 𝑑𝑁 + 𝑀 ∗ (𝑁𝑆 ∗ sin 𝛼 + 𝐸𝑆 ∗ cos 𝛼), (9.8). Where 𝑑𝑁, 𝑑𝐸 are offsets along the coordinate axes.  
𝑁𝑆 , 𝐸𝑆, 𝑁𝑇 , 𝐸𝑇 are Northing and Easting rectangular coordinates on a plane. 𝛼 is the turning 

angle, counted clockwise. 𝑀 is the scale factor.  The formula for inverse transformation for 
coordinates on a plane is: 

𝑋𝑆

𝑌𝑆
=

𝑅−1

𝑀
[[

𝑋𝑇

𝑌𝑇
] − [

𝑑𝑋
𝑑𝑌

]], (9.9) 

The formula of altitude transformation is: 
𝐻𝑇 =  𝐻𝑆 + 𝑑𝐻 + 𝛼𝑁 ∗ 𝑁𝑆 + 𝛼𝐸 ∗ 𝐸𝑆, (9.10). Where 𝐻𝑆 is the height in the original coordinate 
system, 𝑑𝐻 is the height increment, 𝛼𝑁 and 𝛼𝐸 are slope angles along the Northing and Easting 
axes. 
The determination of the transformation parameters of coordinate systems on the plane is 
performed by the ordinary least mean squares method (LMS) by comparing the resulting 
transformation chain 1-4 and the original (from the catalog) coordinates of the points. 
The parameters of the horizontal and vertical transformation and calculated independently.  The 
minimum number of points required for calculation is two points for plane localization and three 
points for vertical localization. 
Local datum includes 4 parameters of plane transformation plus 3 parameters of vertical 
transformation.  Typically, this is called a 4+3 datum.  This highlights the difference between it 
and the datum with 7 parameters, which is used for calculation of geocentric coordinates 
transformations. 
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9.1. Localization Window 

The calculation of the transformation parameters of rectangular coordinate systems on a plane 
and vertical coordinate systems is performed in the Localization window. 
To activate this window, select the main menu item Program, then Coordinate systems (or click 

on the icon . In the opened window, click  and select Localization. 

 
Figure 126: Program - Coordinate Systems – Localization 

The Localization window has a bar of icons across the top, a settings panel and a coordinate 
entry table. 

 
Figure 127: Localization Window 

9.1.1. Icon Bar 

The icon bar contains: 

•  - Save a new localization. 

•  - Save localization as… 

•  - Import files (.jps, .txt). 

•  - Export localization points. 

•  - Calculate localization. 

•  - Restore table default settings. 

•  - Activate / Deactivate bookmark. 

•  - Add columns to enter point coordinates accuracy estimates. 

•  - Add row to end of table. 

•  - Add previous row. 

•  - Remove selected row. 

•  - Delete all rows. 

•  - Set column width to maximum cell length of current column. 
 
By clicking on either of the save icons (save new or save as…) the localization will be saved to 
the program database. 
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Figure 128: Saved Localization 

Select a folder in the Favorites coordinates system.  Not only transformation parameters are 
saved but all table data as well.  It is possible to save unprocessed data. 

9.1.2. Data Table 

The main window is comprised of the data table. The data table is used to display the 
coordinates of points and to estimate the accuracy of the transformation calculation.  Accuracy 
estimation is based on residuals. It depends both on the coordinate quality of the satellite 
network points and the mutual consistency of the reference points, and on the reliability of the 
user-specified projection parameters of the local coordinate system of the Reference.  The 
columns of the table are combined into blocks – Network, Reference, Residuals.  The Network 
block contains coordinates of points in the selected coordinate system.  As a rule, these are the 
coordinates of points obtained from adjusting of the free GNSS network.  Reference block – 
coordinates of points in the local rectangular coordinate system on the plane.  The residuals 
obtained from adjustment are shown in the right part of the table. 

 
Figure 129: Titles of the Data Table 

In the input window, each line contains information about one item and contains the following 
columns: 

• Include – The selected checkbox means that the coordinates of the point will be used 
when calculating the parameters.  Otherwise, the point in excluded from the calculation 
process.  In this case, the corresponding row in the table is shaded, residuals are not 
calculated. 

• Type – Sets the type of transformations in which a specific item can be used. 
 
It is possible to set one of three types of tying to control points: 

•  - Plane and Height.  The coordinates of the points will be used to calculate the 
parameters for the horizontal transformation (Latitude / Longitude or North / East) and 
the vertical transformation (Height). 

•  - Plane.  The coordinates for the points will be used to calculate the parameters for 
the horizontal transformation (Latitude / Longitude or North / East). 

•  - Height.  The coordinates of the points will be used to calculate the parameters of 
the vertical transformation (Height). 

o Name – Item name. 
o Latitude, Longitude, (Height – If parameters for vertical transformation are also 

calculated) from the Network block – coordinates of points in the reference 
coordinate system.  Depending on the type of coordinates which were entered 
into these columns (ellipsoidal or rectangular on a plane), there may be options 
BLH or North / East. 



 

Page 79 of 98 

o North, East, (Height – if parameters for height transformation are also calculated) 
from the Reference block – coordinates of points in the local coordinate system. 

o V (residuals block) – residuals of points of the coordinates by the corresponding 
component and residuals by radius vector. 

 
Figure 130: Item Type Selection 

9.1.3. Working with Input Fields 

For greater clarity and convenience of work, the table uses color highlighting of fields. The 
coordinate columns of points in the original coordinate system are highlighted in green. The 
fields of the residual columns (except for the V column) are highlighted in red before the 
parameters are calculated. After calculating the parameters, the fields of these columns can be 
marked in green if the corresponding corrections to the measurements meet the criteria for the 
τ-test (tau test), or in red if the test is not passed. During the τ-test, the correspondence of 
corrections to the coordinates of points to the estimate of their accuracy obtained from the 
adjustment is analyzed. Therefore, sometimes, even relatively small corrections can be marked 
as not passed the τ-test. In addition to the τ-test, it is important to pay attention to the magnitude 
of the residuals, while evaluating the results of localization. 

If the item is excluded from the calculations (the check-box in the Enable column is unchecked), 
the color of the corresponding line changes to pale green. Fields for the value of the 
corresponding residuals will be empty and will be highlighted in white. 

 To edit the type, names, coordinates of points directly in the table, double-click the 
corresponding field with the left mouse button. To save the editor in the text information input 
columns, press Enter, or by pressing the left mouse button, move the cursor from the edited 
field. 

Empty fields in the Height column are not highlighted in another color. The height value for this 
item will not be considered when calculating the altitude transformation parameters. The 
corresponding field in the residual columns is highlighted in the line by white color: 

 
Figure 131: Data in the Height Column 

When the coordinates are entered in the table in the columns of the Network block and there is 
no value of any planned coordinate (deleted from the table by the operator, omitted in the 
imported file), then the input line is not taken into account in the calculation (site 1516). The 
result will be similar to deleting item information from the table or unchecking the check-box in 
the Enable column). The discrepancies of the row will be zero, and their fields in the table are 
highlighted in white: 
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Figure 132: Missing Data in the Field 

When changing the type of a point, those coordinates that do not belong to this type are 
excluded from the calculations. The fields in the Residuals columns are highlighted in white. For 
example, site 4316 does not use elevation, and site 1536 does not use plane coordinates. 

 
Figure 133: Item Type 

Similar rules apply to coordinate columns of the Reference block. Fields in which coordinates 
are not entered (for all three columns) remain empty, and when importing a file with a 
coordinate value missing in the corresponding input template, a message is displayed indicating 
the line number in which it is absent or incorrect data is given: 

 
Figure 134: Input Error Message 

Window with the message can be closed.  This, it is possible to manually enter the known 
coordinate value leave the field blank. 
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9.1.4. Input Window Tabs 

In addition to the coordinate table, a tab can be activated in the window, in which four 
parameters of the plane transformation (if calculated) are displayed, three parameters of the 
vertical transformation (if calculated), the sum of the squares of the residuals (by the radius 
vector, the Input table section, the description of the Residuals column) and the mean square 
error. 

 
Figure 135: Conversion Options Tab 

9.1.5. Settings Panel 

The settings panel is designed to select various settings and parameters when calculating 
conversion parameters.  All settings are drop-down menu options. 

 
Figure 136: Settings Panel 

• Network Coordinate System – The network coordinates drop-dow list is used to define 
the type of coordinate system for the coordinates that will be imported into the Network 
block. 

 
Figure 137: Selecting the Coordinate Type 

These can be ellipsoidal (BLH) coordinates (set by default), or rectangular coordinates on a 
plane (GRID). Depending on the selected type of coordinate system, the table view is 
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configured, settings for the coordinate input template are selected (section Importing 
coordinates into a table). 

Since the main purpose of the Localization module is to tie the coordinates of global satellite 
navigation systems – WGS-84, obtained as a result of processing / post-processing by the 
Justin program — to ground points, then, mainly, the coordinates of the Network essentially 
denote the coordinates of WGS-84. In this case, the BLH / Grid switch only affects the external 
representation of coordinates since the internal representation of the data in the Justin 
database is WGS-84. 

The situation is different when importing grid coordinates from a file, in which coordinates can 
be specified in any form. Setting the switch allows you to correctly identify the original data, that 
is, convert it to the internal representation of the WGS-84 program. The list of coordinate 
systems offered for selection corresponds to the list available when choosing Program-
Coordinate systems from the main Justin menu. 

The reference coordinate system is characterized by a map projection and a global (spatial) 7-
parameter datum. The purpose of localization is to calculate the parameters of the local datum 
required for transformations of coordinates specified on the plane. 

The local datum is used in the Justin program in addition to the global one, but its calculation 
may be of interest for use in independent coordinate transformation programs. The parameters 
of the map projection are not subject to calculation (except for the value of the axial meridian, 
for those projections where it is available). 

The accuracy of the conversion to local coordinates depends on the accuracy of the initial 
definition of the coordinate system of the Reference. The dependence of the accuracy of 
transformations on the parameters of the global datum is relatively small. In most cases, the 
main source of calculation errors is the inaccuracy of the choice of the central meridian. 
Distortions in the coordinates of the item increase with distance from it. Therefore, the 
parameters of the cartographic projection of a predefined coordinate system of the Reference 
should be as accurate as possible correspond to the real, which are not always known. It is 
possible to recommend the selection of parameters and type of cartographic projection of the 
Reference to achieve the best result. 

If nothing is known about the type and parameters of the cartographic projection of the 
Reference coordinate system, then in the drop-down list of coordinate systems you should 
select Oblique Stereographic, which is equivalent to choosing a stereographic projection with a 
central point calculated as the average between their maximum and minimum values of 
latitudes and longitudes for points of the Network block, zero shifts along the axes and unit 
scale. 

• Transformation – The transformation drop-down list is used to define a set of calculated 
parameters:  

o Plane (default) – 4 parameters of the horizontal transformation are calculated. 
o Height – 3 parameters of the vertical transformation. 
o Plane + Height – 4 parameters of the horizontal and three parameters of the 

vertical transformation. 
o Shift – 2 parameters of the horizontal transformation (shifts slong the North and 

East axes). 
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Figure 138: Transformation Selection 

• Adjust Central Meridian – The checkbox is designed to select the central meridian when 
calculating transformation parameters. 

If the checkbox is not selected, the coordinates of the Grid points are converted to the 
Reference coordinate system using the preset value of the Central Meridian, specified by the 
map projection in the Select projection list of coordinate systems. If the checkbox is checked, 
the meridian is automatically selected for the six-degree zone with the boundaries shifted by 3 
degrees to the left and right relative to the average longitude of the points of the Network block. 
The calculation is performed in a cycle with a longitude step equal to the entered value in the 
Interval window (the preset step value is 10 seconds). The criterion is the estimate of the sum of 
the squares of the residuals. The value of this sum is reflected in line [V2] of the tab with the list 
of calculated parameters. The value of the central meridian, for which the transformation 
parameters were obtained, can be viewed by clicking the edit button. 

 
Figure 139: Plane System Parameters for Translation into the Reference Coordinate System 

The values of these parameters are updated after each calculation of localization with the Auto-
select CM checkbox checked or at any time can be changed manually in this window. If the 
Auto select CM checkbox is not selected, the values of these parameters are entered only 
manually and do not change during the calculation. 

During calculations, the longitude step, the value of the current central meridian for which the 
calculations are being performed, the value of the central meridian for which the best estimate 
of the localization accuracy has been obtained at the moment and the sum of the residual 
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squares are displayed in the Progress window with a progress bar with the Auto-select CM 
checkbox selected. 

 
Figure 140: Progress Window 

Confidence Interval – Confidence intervals are set to searching blunders in the 𝜏 − 𝑡𝑒𝑠𝑡.  The 
95% confidence interval corresponds to stringent criterion whereas the 99% confidence interval 
corresponds to a wider error interval. 

 
Figure 141: Confidence Interval Selection 

9.1.6. Importing Coordinate Points into a Table 

In the bar of icons of the localization window, click .  In the dialog, it is possible to import text 
files of any format and text files of the saved template (*.jl).  In the new window, select the file 
and click open. The Batch Coordinate Processing Templates window will appear, where the 
user may select or configure an import template. 

 
Figure 142: Batch Coordinate Templates Window 
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After creating a template and clicking OK, the coordinates will be imported into the table in 
accordance with the template.  The type of template depends on the coordinate system (XYZ / 
BLH, Grid) from the network coordinate systems drop-down list. 

 
The user may also import text files from a saved template by selecting the *.jl format.  Specify 
the file in the dialog and click open.  The coordinates will be imported into the table. 

9.2. Save Localization 

The user may save a localization by clicking on: 

•  - Save Localization. Type name for a new one. 

•  - Save As Localization. 

 
Figure 143: Save Localization 

Saved Localizations store not only transformation parameters by also localization tables.  It is 
possible to save a table independently.  In this case all parameters equal zero.  All localizations 
are stored in Favorites. 
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10. Antennas 

The antennas panel can be activated through the Program option of the main menu and then 

the Antennas item or by clicking on the  icon in the top ribbon. 

 
Figure 144: Antennas 

The antennas panel is comprised of three panels (Left, Central and Right).  The left panel has 
four items: 

• JAVAD GNSS – Antennas manufactured by JAVAD GNSS. 

• Other – Antennas manufactured by other companies, grouped by company name. 

• User – Antennas added by the user. 

• Last Used – Antennas used in the program. 
 
The central panel contains the name, description and parameters of the antenna selected in the 
lists and is used to edit the antenna parameters and the table of antenna phase center 
variations for antennas in the User list. 
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Figure 145: Selected Antenna Parameters 

• Aliases – The NGS antenna descriptor. 

• Manufacture – The manufacturer of the selected antenna. 

• Description – Optional user description information. 

• Radius – Antenna radius. 

• MPS – The vertical distance from the antenna reference point (ARP) to the height 
measurement mark on the antenna. 

• North, East, Up – Offsets of the phase center relative to ARP toward North, East and 
Altitude for the selected navigation system and frequency. 

 

Clicking on the  icon (in the lower-right of the Antenna window) activates the Diagram 
antenna parameters panel.  This shows a diagram of the main geometric parameters of the 
antenna. 
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Figure 146: Antenna Geometry Diagram 

The right panel contains tables of azimuth and zenith distance of phase center variations for the 
navigation systems and frequencies.  Phase center variations for certified by NGS antennas are 
published on the NGS website and contain data for GPS and GLONASS for L1 / L2 frequencies. 
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Figure 147: Phase Center Variation Table 

Standard antennas manufactured by third-party companies cannot be edited or deleted.  Clone 
and export operations are available. 

 
Figure 148: Clone / Export Options 

A cloned antenna will have a “_Clone” suffix to the name and will be added to the user list. 
Exporting an antenna will allow for exporting the ANTEX file. 
For antennas created by the user, the following options are available: 

 
Figure 149: Custom Antennas Menu 

• Add – Add an antenna named USERANTENNA to the User list with the addition to the 
name “_1”, if the name USERANTENNA is already used. 

• Rename – Edit the name of the antenna. 

• Clone – Clone the antenna name. 
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• Delete – Remove the antenna from the list. 

• Import – Import parameters for the selected antenna from an ANTEX file. 

• Export – Export parameters to ANTEX file. 
 
For antennas in the last list used, an export option to an ANTEX file is available. 

 
Figure 150: Export Option 

The ribbon on the left panel contains the following options: 

 
Figure 151: Left Panel Options 

•  Add – Adding an antenna named USERANTENNA to the user list. 

•  Rename – Rename the antenna name. 

•  Clone – Clone the antenna. 

•  Delete – Delete the antenna. 

•  Import – Import of antenna parameters into ANTEX file. 

•  Export – Export antenna parameters into ANTX File. 

•  Update Antenna Database – Update the antenna database. 

•  Show Diagram of Antenna Parameters – Display Antenna Diagram. 
 
The central and right panels for the JAVAD GNSS, Other and Last Used are for informational 
purposes only.  For antennas selected in the User list, the ribbon of icons on the central panel 
become active.  The parameters and variations of the phase center of the selected antenna 
become available for editing. 

 
Figure 152: Central Panel (Active) Options 

•  Save – Save changes in parameters. 

•  Add – Add a table of phase center variations for a specific navigation system and for 
a specific signal type. 

•  Copy – Copy the phase center variation table.  The copied table is copied to an Excel 
or Notepad++ file, where the values can be edited.  The edited data is copied to the 
program. 

•  Paste – Paste the phase center variation table copied into Excel or Notepad++. 

•  Delete – Delete the phase center variation table for a specific navigation system and 
for a specific signal type.  Editing parameters can be initiated by a double-click. 
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11. Aerial Camera Editor 

To calculate the coordinates of camera exposure moments (events), it is necessary to set the 
initial parameters. 
The aerial cameras editor window can be activated by selecting the Program item of the main 
menu and then the Cameras item. 

 
Figure 153: Aerial Camera Editor Window 

The left panel has lists of cameras and airplanes defined within the program. The ribbon above 
the left panel contains: 

•  - Enter the parameters of a new camera. 
- Create a set of shifts. 

•  - Create a backup file.  Creation of a *.jac file, in which all information about shifts 
and cameras available is saved. 

•  - Restore a backup file.  Restore information about shifts and cameras from a *.jac 
file.  It is possible to edit names of the aircraft and the camera by double-clicking on the 
name of the camera or the aircraft. 

Right-clicking on any element on the left side of the window opens a menu that duplicates the 
ribbon, with the addition of the following items: 

 
Figure 154: New Camera / New Airplane Menus 

New Camera and New Airplane will bring up the parameters window for each: 
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Figure 155: New Camera / New Airplane Parameters 

The right panel of the aerial camera editor window contains information about shifts and camera 
parameters selected in the left panel.  It is used to exchanged information between the project 
and the program.  The main functions are implemented in the ribbon of icons or right-clicking on 
an object. The right panel has two tabs: Edit and Project. Further details on each is described 
below. 
The edit tab is used to view and edit sets of shifts and camera parameters. Forw / Back allos to 
set the offset, which is measured along the aircraft axis from the antenna phase center to the 
center of the film plane with corresponding signs. 

 
Figure 156: Forw / Back Offset 

Left / Right allows to set the offset, which is measured across the aircraft axis from the phase 
center of the antenna to the center of the film plane with corresponding signs. 
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Figure 157: Left / Right Offset 

Vertical allows to set distances from the ARP antenna to the film plane, which is measured 
along the vertical axis. 

 
Figure 158: Edit Tab for Cameras 

The delay interval (milliseconds) allows to set delay between the moment of camera exposure 
and the event time measured by the receiver. 
Focal length (millimeters) allows you to set the focal length of the camera. 
Distance to the film (millimeters) allows you to set the distance to the film plane, which is 
measured from the center of rotation of the camera to the film plane. The distance will be 
positive if the center of rotation of the camera is below the plane of the film. 
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If Gyro mount is checked, the camera was used “with a gyro platform”, and the camera 
orientation angles should be used when calculating the coordinates of the events. Otherwise, 
aircraft orientation angles should be specified manually (Main menu>>View>>Events). 
The Project item shows lists of airplanes and cameras in the project database. 

 
Figure 159: Project Tab 

To copy from the program database to the project database, use the green arrow (left and right) 
buttons. 
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12. Coordinate Calculator 

The coordinate calculator is launched by pressing the  icon. 

 
Figure 160: Coordinate Calculator 

The calculator window consists of two panels, where it is possible to select a source and target 
coordinate systems (in the future CS) from a list. To expand the list copy CS from the Favorites 
folder or the Project database folder; it is possible to copy any number of CS from the program 
database to these folders. Establishing new CS in the program database and copying them to 
the appropriate folders is described in “Chapter 7. Coordinate systems manager” on page 61. 
Coordinates are recalculated by pressing the green (left and right) arrows. Both panels are 
equivalent and the panel selection for entering the initial coordinates does not matter. 
The choice of the source and the resulting CSs in both panels is carried out in the drop-down list 
of the CS of the calculator: 

 
Figure 161: Project SC Drop-Down List 

Clicking on the  button opens a window with CS list in the favorites folder. 
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Figure 162: CS List in Favorites Folder 

The CS selected in this window in any folder after clicking OK is entered automatically into the 
calculator’s CS list. 
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Figure 163: CS Parameters 

By clicking the button activates the window with the parameters selected CS: 
The color of the arrow and the label show the direction of conversion, for which the parameters 
are given. 
In the upper left corner of the panel, the type of CS selected in the panel is displayed: XYZ, BLH 
or Grid, respectively, the CS changes the type of input coordinates and labels to the input fields. 
Define the epoch for both the initial and final coordinates in the field. 
For the batch recalculation of coordinates, click the button “Convert coordinate file”, select the 
file containing the coordinates in the window “Select source coordinate file” and click Open.  
In the window “Enter destination coordinate file,” enter the name of the file where recalculated 
coordinates will be placed and click save.  
It is necessary to specify templates of formats for input and output of coordinates. After that 
coordinates can be recalculated correctly. 
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Figure 164: Coordinate Input Template 

 
Figure 165: Coordinate Output Template 


